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Getting Help 
If you have questions  
about the VIPR Vendor Solution,  
contact the Interagency Incident 
Systems Helpdesk: 

y E-mail: helpdesk@dms.nwcg.gov 

y Telephone: (866) 224-7677; press 
Option 3 for VIPR / eAuth 

y Hours: 12:00 p.m.- 8:00 p.m. 
Eastern Time (Monday – Saturday) 

 Contents  
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 Bus iness  Requirements  

To obtain an I-BPA with the Forest Service, you must meet the business 
requirements described on the Incident Procurement Web site at 
 http://www.fs.fed.us/business/incident/vendors.php. 
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y VIPR Vendor Solution User Guide. Provides detailed instructions and 
information for the Vendor to use during the complete procurement 
process.  
http://www.fs.fed.us/business/incident/vendorsupport.php  

y Vendor Support. Provides access to user documentation, training tools 
(i.e. tutorials), and links to additional information for Vendors to use to 
assist them with using the VIPR Vendor Solution.  http://www.fs.fed.us/
business/incident/vendorsupport.php 

y Forest Service Incident Procurement VIPR Web site. Provides 
incident procurement information and tools to current and potential 
Vendors.  
http://www.fs.fed.us/business/incident/vipr.php 

y Frequently Asked Questions. Lists common questions and answers 
regarding all aspects of VIPR and the VIPR Vendor Solution.  
http://www.fs.fed.us/business/incident/faq.php 

Before you begin, ensure you meet the following system requirements:   

9 Windows® NT, 2000, XP, or VISTA 

9 Free Formatta Filler® software 

9 1 MB space available for downloading the free Formatta Filler software 

9 Internet Explorer® 6.0 or better, with Java script enabled 

9 Popup blocker turned off 

Instructions for how to check this information are located on page 22. 

 System Requirements  

The Forest Service Virtual Incident Procurement (VIPR) system is a web-based incident procurement system. Contracting Officers (COs) use VIPR to create and 
manage solicitations and award agreements, encompassing the entire business process. Vendors (a.k.a. Contractors) will not directly access VIPR to respond to 
a solicitation. When COs post their solicitation packages to FedBizOpps (FBO), Vendors download the packages from FBO, and then use the VIPR Vendor 
Solution, a forms-based tool connected to the VIPR system, to respond to solicitations by completing the forms provided as attachments to the solicitation (i.e. 
Vendor company form and resource data entry forms) and submitting the completed forms as attachments to the SF 1449 when responding to the solicitation. 
VIPR will populate the SF 1449 form when an award is made. Vendors need only respond to the latest amendment by submitting the entire package (all forms) 
with any necessary revisions.  

All Vendors who wish to obtain a preseason incident agreement  
(a.k.a. Incident Blanket Purchase Agreement [I-BPA]) with the  
Forest Service MUST use the VIPR Vendor Solution.  
The VIPR Vendor Solution provides these key functions: 

y Automated forms for submission of Vendor offers  

y Automated confirmation that Vendor submissions are received  

y Secure, electronic signatures on awarded agreements  

 Us ing the VIPR Vendor  Solut ion 

TIP: This VIPR Vendor Solution Quick Reference Guide 
provides a high-level view of the instructions needed for 

completing the different phases of the procurement process. For 
more detailed instructions, which include sample graphics of 
what the Vendor would see during the procurement process, 
refer to the VIPR Vendor Solution User Guide, which is located at 
http://www.fs.fed.us/business/incident/vendorsupport.php.  

 Key Resources  
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 H igh- level  V iew of  the VIPR Vendor  Solut ion Process  
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Access the FBO Web site at http://www.fbo.gov/ and in the center of the page under 
Find Opportunities, click on Advanced Search.  

From the Opportunities screen, in the Keywords/SOL# field, type the solicitation 
number or type “VIPR I-BPA.”   

In the Posted Date field, select the appropriate date range, and then click the Go 
button. A list of all of the solicitations that match your search criteria appears. 

Click on the link from the search results to view the Notice Details for the solicitation. 

1 

 Locat ing Sol ic i tat ions  at  FedBizOpps (FBO) 

2 

3 

4 

TIP: The Forest Service solicitation packages (.pff files) 
can only be viewed, completed, and submitted using the 

free Formatta Filler software; other applications that are 
used to view and fill in forms (e.g., Adobe Reader) will 
NOT WORK with the VIPR Vendor Solution. For instructions 
on how to install Formatta Filler, go to the Incident 
Procurement VIPR Web site at http://www.fs.fed.us/
business/incident/vendorsupport.php.    

 Responding to  a  Sol ic i tat ion 

 Downloading a  Sol ic i tat ion Package from FedBizOpps (FBO) 

Access the FBO Web site at http://www.fbo.gov/. 

From the Opportunity List, find the solicitation you wish to respond to, and then click on the solicitation link 
within the list.  

From the ALL FILES section on the right side of the screen, click on the http link for the solicitation package.  

From the File Download dialog box, click the Save button.  

From the Save As dialog box, in the Save in: field, open the My Documents | My Forms folder.  

Within the My Documents | My Forms folder, create a new “Solicitations | <solicitation number>” folder 
and save the <solicitation number>.pff in the <solicitation number> folder. 

From the File Download dialog box, click the Open Folder button.  

Make a copy of the solicitation package and rename the copy as “Original-<solicitation number>.” This saves 
an original version of the solicitation package should you ever need to refer to it. For example, if you 
inadvertently deleted a form from your working version of the solicitation, then you can retrieve a blank form 
from the original version of the solicitation and would not need to download the solicitation package again.   

The download is complete. You have an original version of the solicitation and a working version of the 
solicitation saved to your local hard drive.  

1 
2 

3 
4 
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8 

TIP: You will need to respond to 
the latest version of the 

package, which is always in the ALL 
FILES list. If the solicitation has 
amendments, then you will only need 
to respond to the latest amendment 
package for that solicitation—you will 
not need to respond to both the 
solicitation package and the 
amendment package for that 
solicitation.  

If you have responded to a 
solicitation and it has been amended 
since you first responded, then VIPR 
will notify you of the amendment and 
you will need to follow the 
instructions in “Responding to an 
Amended Solicitation.”  

To respond to a solicitation, you will need to do the following: (1) download the solicitation package, (2) view the contract requirements and exhibits, (3)
complete the Vendor Company Information, (4) complete the Resource (Equipment) Information, (5) completing the Representations/Certifications  
(FAR 52.212-3), and (6) sign and submit your offer. NOTE: Tasks 3 through 5 can be performed in any order. 

VIPR Vendor Solution Quick Reference Guide 
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 Responding to  a  Sol ic i tat ion (Cont inued)  
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From Windows Explorer, open the Solicitations | <solicitation number> 
folder. 

Double-click on the <solicitation number>.pff file or the <solicitation 
number_Amendment #>.pff file. The SF 1449 form for that solicitation 
opens. 

From the Form menu, select Attachments. (You can also click on the paper 
clip icon to access the Attachments.) A list of Attachments appears. 

From the list of Attachments, double-click on the 
ContractRequirements.pdf file, which will vary depending on the type of 
solicitation.  

NOTE: If a message appears warning you that attachments may contain 
viruses, you can ignore it because the attachment is a valid document. Click 
Yes to open the attachment.   

Review the solicitation to ensure that you understand and can comply with 
the contract requirements, and then close the document.  

From the list of Attachments, double-click on an Exhibits document, which 
will vary depending on the type of solicitation.  

Review the Exhibits document to ensure that you understand and can comply 
with the requirements, and then close the document.  

Repeat Steps 6-7 for each Exhibits document within the package. 

 

 V iewing the Contract  Requirements  and Exhibi ts  

1 

2 

3 

4 

5 

Before you start completing the forms within a solicitation or amendment 
package, you should first review the contract requirements and exhibits for that 
specific solicitation. The contract requirements and exhibits are included as 
“attachments” to the SF 1449 form, which is visible when the package is opened.  

To view the contract requires and exhibits for a solicitation: 

To set up the main “Solicitations” folder 
as the default location for your form  
files and attachments:  

Open any Formatta form (SF 1449, company 
form, etc.). 

From the Tools menu, select Options... 

From the General tab, click the Browse 
button. 

From Browse for Folder, find the Solicitations 
folder, and then click the OK button.   

Unless you wish to change the default file 
location again, you will only need to do  
this once. 

VIPR Vendor Solution Quick Reference Guide 
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 Responding to  a  Sol ic i tat ion (Cont inued)  

 Complet ing the  Vendor  Company Information 

From Windows Explorer, open the Solicitations | <solicitation number> folder. 

Double-click on the <solicitation number>.pff file or the <solicitation number_Amendment #>.pff file. The SF 1449 form for that solicitation opens. 

From the Form menu, select Attachments. (You can also click on the paper clip icon to access the Attachments.) A list of Attachments appears. 

Depending on your situation, do one of the following: 

y If you have submitted responses to previous solicitations and already have a completed Vendor Company Information form, then proceed to Step 5. 

y If this is the first time you have responded to a solicitation, then do the following: 

a. From the Attachments list, double-click on the VendorCompany.pff file. The Vendor Company Information Form appears. 

IMPORTANT: When you double-click on a form from within the Attachments list, the work you do in that form will NOT automatically 
replace the blank form that is currently attached to the SF 1449 form. The process required to replace the blank attachment with your 
completed form is described later in the steps below.  

b.  From the File menu, select Save As.  

NOTE:  The first time you save a form that you opened through the Attachments list, you must do a File | Save As or click the Save 
button at the bottom of the form to save the form to the Solicitations folder. After the initial save, then you can use the Save icon from 
the toolbar. 

c.  From the Save in: field, find the Solicitations folder.  

d.  In the File name: field, highlight “VendorCompany[#],” type your company name, and then click the Save button.  

e.  Complete the form.  

IMPORTANT:  You MUST complete all of the required fields, which are indicated by an asterisk and yellow background on the form. 
Also, the company name you use in the form MUST match the company name you use in CCR. 

f.  Once you have entered all of your data, click the Validate Form button (located at the bottom of the form) to ensure you have completed all 
of the required fields and entered data correctly. If you receive have questions about the validation errors, contact the Interagency Incident 
Systems Helpdesk at helpdesk@dms.nwcg.gov or (866) 224-7677 (press Option 3 for VIPR). 

h.  Once your changes are complete, click the Save button (located at the top in the Form toolbar and at the bottom of the form). Your completed 
company form is saved in the Solicitations folder. 

i.  Click the Close button in the upper right corner of the Vendor Company Information form. The company form closes and the Attachments list 
appears.  

1 
2 
3 
4 

TIP: When completing 
the Vendor Company 

Information form,  
you MUST: 

y Complete all of the 
required fields, which 
are indicated by an 
asterisk and yellow 
background on the 
form.  

y For “Company 
Name,” use the 
same company name 
you use for Central 
Contractor 
Registration (CCR). 

y Ensure your e-mail 
address is correct.  
Award confirmation 
is provided 
electronically; an 
incorrect e-mail 
address may result in 
no delivery of the 
award notification. 

Business Rule:   
You MUST attach a 
completed Vendor 
Company Information 
form to EVERY offer 
you submit.  

VIPR Vendor Solution Quick Reference Guide 
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 Responding to  a  Sol ic i tat ion (Cont inued)  
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Use the same 
company name that 
you use in Central 
Contractor 
Registration (CCR). 

This is your  
9-digit DUNS 
number. Provide contact 

information for at 
least one company 
representative; this 
representative will be 
signing solicitation 
responses, so the 
person must have an 
eAuthentication Level 
2 account.  

Use this to ensure 
you have entered 
data in all of the 
required fields. 

Enter the Mailing 
Address only if it is 
different than the 
Company Address. 

You only need to fill out the Vendor Company Information form once and then you can use the one completed company form for 
all of your solicitation responses. You can make updates to this form at any time.  

Verify the 
accuracy of 
your e-mail 
address. Award 
confirmation is 
provided 
electronically 
and an 
incorrect  
e-mail address 
may result in 
failure to 
deliver the 
award 
notification. 

Use your payment  
address. 

Your “Small Business 
Status” selection 
must match your 
Small Business 
Status in ORCA or as 
certified in FAR 
Clause 52-212.3. 

 Example  of  the Vendor  Company Informat ion Form 

Ensure you 
are using the 
latest version 
of the form. 
The packages 
you download 
from FBO will 
always have 
the latest 
version of this 
form. 

VIPR Vendor Solution Quick Reference Guide 

In the following steps, you will ensure the version of 
your completed company form is current, add your 
completed company form to the SF 1449 form, and 
delete the blank Vendor Company Information form that 
is still attached to the SF 1449 form.  

From the Attachments list, double-click on the 
VendorCompany.pff form within the solicitation (or 
amendment package). 

Scroll to the bottom of the form and check the Version 
# on the form.  

Depending on the version of the form, do one of the 
following: 

y If the Version # on the form matches the Version 
# of the form that you had previously completed 
for other solicitations, then close the form, and 
proceed to Step 8.  

y If the Version # on the form is a newer Version 
than the form you had previously completed, go 
back to Step 4b, complete Steps 4b-4i to complete 
and save the newer version of the company form, 
and then proceed to Step 8.  

From the Attachments list, click the Add button. The 
Open dialog box appears. 

From the Solicitations folder, select your completed 
<companyname>.pff form, and then click the Open 
button. Your completed company form attaches to the 
solicitation package and you can see your company form 
is now in the list of Attachments.  

From the Attachments list, select the 
VendorCompany.pff file, and then click the Delete 
button.  

The original blank Vendor company form is removed 
from the solicitation package.  

Complet ing the Vendor  
Company Informat ion (Cont ’d)   
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 Complet ing the  Resource (Equipment)  Information 

From Windows Explorer, open the Solicitations | <solicitation number> folder. 

Double-click on the <solicitation number>.pff file or the <solicitation number_Amendment #>.pff file. The SF 1449 form for that solicitation opens. 

From the Form menu, select Attachments. (You can also click on the paper clip icon to access the Attachments.) A list of Attachments appears. 

Depending on your situation, do one of the following: 

y If you have gone through this response process before and have already completed your resource data entry forms, proceed to Step 5. 

y If you are going through this response process for the first time, then do the following: 

a.  From the Attachments list, double-click on a <resource data entry form>.pff file. The specific resource data entry form appears. In 
this example, the Dozer, Type 1 form appears. 

IMPORTANT: When you double-click on a form from within the Attachments list, the work you do in that form will NOT automatically 
replace the blank form that is currently attached to the SF 1449 form. The process required to replace the blank attachment with your 
completed form is described later in the steps below.  

b.  From the File menu, select Save As. The Save As dialog box appears. 

NOTE:  The first time you save a form that you opened through the Attachments list, you must do a File | Save As or click the 
Save button at the bottom of the form to save the form to the Solicitations folder. After the initial save, then you can use the Save 
icon from the Form toolbar. 

c.  From the Save in: field, find the Solicitations folder if it is not already selected.  

d.  In the File name: field, highlight the <resource name [#]>, type the name of your resource, and then click the Save button. The 
resource data entry form is saved in the Solicitations folder. 

e.  Complete the form.  

IMPORTANT: You must complete all of the required fields, which are indicated by an asterisk and yellow background on the form. 
When selecting a dispatch center, visit the Incident Procurement Web site at http://www.fs.fed.us/business/incident/vipr.php.  

g.  Once you have entered all of your data, click the Validate Form button (located at the bottom of the form) to ensure you have 
completed all of the required fields and entered data correctly. If you receive a validation error and have questions or need assistance, 
contact the Interagency Incident Systems Helpdesk at helpdesk@dms.nwcg.gov or (866) 224-7677 (press Option 3 for VIPR). 

h.  Once your changes are complete, click the Save button (located at the top in the Form toolbar and at the bottom of the form). Your 
completed resource data entry form is saved in the Solicitations folder. 

i.  Repeat Steps 4a – 4h for every resource that you wish to include in your solicitation response.  

IMPORTANT:  You must complete a resource data entry form for every resource that will be in your solicitation response. For 
example, if your response will include two Dozer Type 1s, then you will need to complete two Dozer Type 1 forms; you CANNOT 
use one form for both Dozers. You can copy one completed Dozer form, rename the file, and then complete the information 
specific to the other Dozer. 

j.  Click the Close button in the upper right corner of the form. The resource data entry form closes and the Attachments list appears. 
Proceed to Step 5. 

1 
2 
3 
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 Responding to  a  Sol ic i tat ion (Cont inued)  

TIPS:  

y When changing the name 
of the file for your resource, 
you may want to use a name 
specific to the piece of 
equipment, e.g., VIN number, 
Equipment ID, etc.  

y The Attachments list contains a 
resource data entry form for 
each type of resource 
(equipment) included in the 
solicitation; however, you only 
need to complete the resource 
data entry forms for the type of 
equipment that you wish to 
include with your offer. 

y Be sure to delete ALL of the 
blank forms from the package, 
including the resource data 
entry forms that you do not 
use, otherwise, when you 
submit your offer, you will get 
an error because there are 
blank forms in your solicitation 
package. 

Business Rule:   
You MUST complete a resource 
data entry form for every resource 
that will be in your solicitation 
response. For example, if your 
response will include two Dozer 
Type 1s, then you will need to 
complete two Dozer Type 1 forms; 
you CANNOT use one form for 
both Dozers. You can copy one 
completed Dozer form, rename the 
file, and then complete the 
information specific to the other 
Dozer. 

VIPR Vendor Solution Quick Reference Guide 
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 Responding to  a  Sol ic i tat ion (Cont inued)  

In the following steps, you will ensure the version of your resource 
data entry form is current, add your completed resource data entry 
form(s) to the SF 1449 form and then delete the blank resource 
data entry forms that are still attached to the SF 1449 form.  

From the Attachments list, double-click on the <resource data 
entry form>.pff form. 

Scroll to the bottom of the form and check the Version # on the 
form. 

Depending on the version of the form, do one of the following: 

y If the Version # on the form matches the Version # of the 
form that you had previously completed for other solicitations, 
then close the form, and proceed to Step 8.  

y If the Version # on the form is a newer Version than the form 
you had previously completed, go back to Step 4b, complete 
Steps 4b-4i to complete and save the newer version of the 
company form, and then close the form and proceed to Step 8.  

From the Attachments list, click the Add button. The Open file 
dialog box appears. 

From the Solicitations folder, select your completed resource data 
entry form, and then click the Open button. Your completed 
resource form is now attached to the solicitation package. 

From the Attachments list, select the <resource data entry 
form>.pff file, and then click the Delete button. The original blank 
resource form is deleted from the package.  

Repeat Steps 5-10 for all resource data entry forms that will be 
included in your solicitation response and to delete ALL of the blank 
resource data entry forms.  

IMPORTANT: If a solicitation requires additional 
information to be submitted with the offer, i.e. resumes, 
certifications, etc., use the Add button in the Attachments 
list to add those documents to the solicitation package. 

Be sure to delete ALL of the blank forms from the package, 
including the resource data entry forms that you do not use, 
otherwise, when you submit your offer, you will get an error 
because there are blank forms in your solicitation package.  

 Complet ing the  Resource  
 (Equipment)  Informat ion (Cont ’d)   Below is an example of a resource data entry form. The data fields on each resource data entry 

form will vary depending on the type of information needed for that resource. 

 Example  of  a  Resource Data Entry  Form 

Use this to 
ensure you 
have entered 
data in all of 
the required 
fields. 

For forms 
that have 
this box, 
only use it 
during the 
Agreement 
Phase, if 
needed. 

The rate  
value(s) must 
be greater 
than zero (0). 

For instructions 
on how to 
select the 
appropriate 
Dispatch 
Center, view 
http://
www.fs.fed.us/
business/
incident/
vipr.php 

VIPR Vendor Solution Quick Reference Guide 

5 

6 

7 

8 

9 

10 

11 

http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�
http://www.fs.fed.us/business/incident/vipr.php�


10 USDA Forest Service – Acquisition Management 

 Responding to  a  Sol ic i tat ion (Cont inued)  
  Complet ing Representat ions-Cert i f icat ions (FAR 52.212-3)  

You are required to complete FAR 52.212-3, Offeror Representations and Certifications – Commercial Items (Section E-3) with your offer.  
To complete this submission, you can do any of the following: 

y Use the Online Representations and Certifications Application (ORCA) at http://orca.bpn.gov to electronically complete the annual 
representations and certifications in accordance with FAR 52.212-3. 

 NOTE:  If you use ORCA, you are not required to submit your representations and certifications with your offer. 

y Download the FAR 52.212-3 clause from http://www.acquisition.gov/comp/far/index.html, complete and save the document and then 
print and mail the hardcopy document to the Issued By office, which is in Box 9 on the SF 1449 form. 

y Download the FAR 52.212-3 clause from the solicitation package, complete and save the document, and then attach the document to 
your offer (as described below).  

Business Rules:   
y UNLESS you have completed 

the information electronically 
using ORCA, you must submit 
this information for each 
solicitation you respond to. 
However, you will only need to 
provide the representations and 
certifications once for a 
solicitation unless that specific 
information has been modified, 
which will be specified on the 
SF 30 form of an amendment 
package.  

y Unless you have completed the 
information electronically using 
ORCA, you MUST submit this 
information for each solicitation 
you respond to. However, you 
will only need to provide the 
representations and 
certifications once for a 
solicitation unless that specific 
information has been modified, 
which will be specified on the 
SF 30 form of an amendment 
package. If you respond to 
different packages for a specific 
solicitation (amendment 
package, agreement package, 
and modification package), you 
do not need to re-submit your 
representations and 
certifications again for those 
packages.  

y If you choose to submit a 
hardcopy of the representations 
and certifications document, 
the CO must receive the 
hardcopy document by the 
solicitation close date and time. 

From Windows Explorer, open the Solicitations | <solicitation number> folder. 

Double-click on the <solicitation number>.pff file. The SF 1449 form opens. 

From the Form menu, select Attachments. (You can also click on the paper clip icon to access the Attachments.) A list of Attachments appears.   

From the list of Attachments, double-click on the Representations-Certifications -FAR 52.212-3.doc file. The document opens.  

NOTE: If a message appears warning you that attachments may contain viruses, you can ignore it because the attachment is a valid document. 
Click Yes to open the attachment.   

Within the document, from the File menu, select Save As. The Save As dialog box appears. 

NOTE: The first time you save a document that you opened through the Attachments list, you must do a File | Save As to save the document 
to the Solicitations folder. Otherwise, your document will be saved to C:\Documents and Settings\<your username>\Local Settings\Temp\. 

In the Save in: field, open the Solicitations | <solicitation number> folder, and click the Save button.  

In the document, complete all of the editable areas that are specific to your solicitation response. 

NOTE: Editable areas within the document are indicated by highlighted brackets. All other information with the document is non-editable.  

Save your changes, and then close the document. 

From the Attachments list, select the original Representations-Certifications -FAR 52.212-3.doc, and then click the Delete button. The original 
document is removed from the solicitation package.  

From the Attachments list, click the Add button. The Open dialog box appears. 

Access the Solicitations folder, select your completed Representations-Certifications FAR 52.212-3 document, and then click the Open button. 
Your completed document attaches to the solicitation package.  

If have completed and attached all of the required documents/forms, then close the Attachments box and return to the SF 1449 form where you 
can sign and submit your offer. 

1 
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 Responding to  a  Sol ic i tat ion (Cont inued)  

From Windows Explorer, open the Solicitations | <solicitation number> folder. 

Double-click on the <solicitation number>.pff file or if the solicitation has an amendment, then double-click on the <solicitation number_Amendment #>.pff 
file. The SF 1449 form opens. 

At the bottom of the SF 1449 form, click the Sign Response button. A message appears explaining what it means when you use your eAuthentication UserID and 
password to sign a response. 

Click Yes to proceed.  

IMPORTANT: Once you complete the steps for the eAuthentication process for a specific solicitation (Steps 5-11 below), you might not be required to perform those 
steps again the next time you click the “Sign Response” button on the SF 1449 form for that solicitation. If this occurs, it means your eAuthentication login information is 
already in the system and you can go from Step 4 to Step 12. 

If an authorization message appears, click the Continue button once and wait a few seconds for this window to be replaced with the eAuthentication Web site warning 
message. 

NOTE: You may need to drag the window edges to re-size the window in order to view the entire message. 

From the eAuthentication Warning message box, click the Continue button. The eAuthentication Login screen appears. 

NOTE: You may need to drag the window edges to re-size the window in order to view the entire message. 

Enter your eAuthentication username and password, and then click the Login button.  

NOTE: If you do not remember your eAuthentication username or password, contact the ITS Service Desk at eAuthHelpDesk@ftc.usda.gov or  
800-457-3642. 

A Security Alert message appears. You can ignore this message because the VIPR site is secure. 

Click Yes to continue. A message informing you that you are authorized to submit your response appears. 

Click on the Close button to close the message window. The SF 1449 form re-appears. 

From the SF 1449 form, click the Sign Response button again. The message explaining what it means when you use your eAuthentication UserID and password to sign 
a response re-appears. 

Click Yes to proceed.  

VIPR conducts a validation test to check for the following: 

y For every solicitation response, your company information form and at least one resource data entry form specific to the solicitation are attached to the SF 1449 
form. However, VIPR cannot ensure that all resource data entry forms specific to your equipment are attached. 

y Each resource data entry form has a unique Vendor-provided identifier (e.g., VIN number, Equipment ID, etc.). The same identifier cannot be used for the same 
resource type for the same solicitation.  

y The forms attached to the solicitation response are the correct version of the forms. If the forms are the incorrect version due to a change in the form or an 
amendment, VIPR will notify you and you will need to download the latest version of the solicitation package from FBO, complete the solicitation package with the 
new version of the forms, and re-submit your offer.  

You will receive either a successful submittal message or an error message. Details about each type of message are explained in the “Types of Submittal  
Response Messages.” 

1 
2 

3 

4 

Business Rules:   
y You can 

continue to 
update your 
company and 
resource 
information and 
re-submit a 
solicitation 
package until 
the solicitation 
close date. After 
the close date, 
VIPR will NOT 
accept a 
response unless 
the CO has 
notified you of a 
problem and 
allows you to re-
submit your 
response or has 
entered into 
negotiations and 
requested a 
revised offer. 

 
y VIPR will use the 

Vendor’s last 
response as the 
response on 
record; VIPR will 
NOT try to 
determine the 
difference 
between 
multiple 
packages for the 
same solicitation 
sent by the 
same Vendor. 

VIPR Vendor Solution Quick Reference Guide 
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VIPR Vendor Solution Quick Reference Guide 

Successful submittal: Your offer has been received in the VIPR system. If there 
are amendments to this solicitation, then VIPR will notify you. Otherwise, you will 
not be notified about the status of your offer for this solicitation until after the 
solicitation close date. NOTE: When your response is successfully submitted, you 
have met the requirement described in Box 28 of the SF 1449 form which is to 
provide a signature and a copy of the form. 

 

 

Your completed Vendor Information form was not attached to the 
solicitation: Ensure you have attached your completed company form AND 
deleted the blank Vendor Company Information form. 

 

 

Your completed resource data entry form was not attached to the solicitation: Ensure you have 
attached your completed resource data entry forms that are specific to the solicitation AND deleted all 
blank resource data entry forms.  

 

 

 

You have an incomplete form within the package. Required fields on either the 
Vendor Company form and/or a resource data entry form may be incomplete OR 
blank forms have not been deleted from the package: This message is just one 
example for an attached data entry form (Mobile Laundry Type 1) that has an incomplete 
field that is required for the form. Check your forms to ensure all required fields are 

completed and then add the completed forms to the solicitation (or amendment) package and sign and submit your response. NOTE: Ensure 
you have deleted all blank resource data entry forms from the package; otherwise, you will get error messages similar to this one for all of the 
required fields for every blank form that is still attached to the package. 

 S igning and Submitt ing an Offer :  Types of  Submit ta l  Response Messages  
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 S igning and Submitt ing an Offer :  Types of  Submit ta l  Response Messages (Cont inued)  

You have not responded to the latest amendment package: You may not be working with 
the most current amendment package that was posted to FBO. If a solicitation has been amended 
after you have downloaded the solicitation or another amendment package, but before you have 
submitted an offer, then you may get this error message. Access the FBO Web site and download 
the latest amendment package for the solicitation, attach your completed forms to the amendment 
package, and sign and submit your response. 

 

 

All of the amendment files are not attached to the amendment package: Ensure you 
have not deleted an Amendment#.pff file from the amendment package. If an Amendment 
file is not in the package, then you may have inadvertently deleted an Amendment#.pff file. 

Use the “original” <solicitation number_Amendment#>.pff file that you saved to your local drive to find the missing Amendment files, re-attached the missing 
Amendment#.pff files to the “working” amendment package, and then sign and submit your response again.  

 
If you have questions about an error message and/or need assistance,  

contact the Interagency Incident Systems Helpdesk at  
helpdesk@dms.nwcg.gov or (866) 224-7677. Press Option 3 for VIPR / eAuth.  

If an error message has a reference number in it, make a note of  
the number and provide the reference number to the Helpdesk. 

mailto:helpdesk@dms.nwcg.gov�
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From Windows Explorer, open the Solicitations folder. 

Double-click on your company form or the resource data entry form that you wish to update.  

Make any necessary changes to the company information form and/or the resource forms.  

Once you have entered all of your data, click the Validate Form button (at the bottom of each form) to 
ensure you have completed all of the required fields and entered data correctly. 

Once your updates are complete, click the Save button (located at the top in the Form toolbar and at the 
bottom of the form). 

Repeat Steps 2-5 for every form you wish to update.  

From Windows Explorer, open the Solicitations | <solicitation number> folder. 

Double-click on the <solicitation number>.pff file or if the solicitation has an amendment, double-click 
on the <solicitation number_Amendment #>.pff file. The SF 1449 form appears. 

From the Form menu, select Attachments. (You can also click on the paper clip icon to access the 
Attachments.) 

From the Attachments list, select the .pff file that you are going to replace, and then click the Delete 
button. Your old form is deleted from the package.  

From the Attachments list, click the Add button.  

From the Solicitations folder, select your updated form, and then click the Open button. Your updated form 
is now attached to the solicitation package. 

Repeat Steps 10-12 for every form that you wish to replace with an updated form.  

Click the Close button to close the Attachments list.  

Click the Save button to save your updated solicitation package. 

Once the updated information is attached to the SF 1449 form, go to “Signing and Submitting an Offer,” to 
sign and submit your offer. 

1 
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Business Rules:   
y You can update your 

company and resource 
information and re-submit a 
revised offer at any time until 
the solicitation close date. 
 

y VIPR will use the Vendor’s 
last response as the response 
on record; VIPR will NOT try 
to determine the difference 
between multiple packages 
for the same solicitation sent 
by the same Vendor. 
 

y If the information you have 
updated applies to other 
solicitations you have 
responded to, then you must 
repeat this process for each 
solicitation you responded to. 

5 

6 

7 
8 

9 

10 

11 

12 

13 
14 

15 

VIPR Vendor Solution Quick Reference Guide 

  Submitt ing a  Revised Offer  on an Open Sol ic i tat ion 
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 Submitt ing  a  Revised Offer  (Cont inued)   

Business Rule:   
After a solicitation is closed, you CANNOT update your 
information and submit a revised offer for that solicitation 
UNLESS the CO has notified you of a problem and allows 
you to re-submit your response or the CO has entered into 
negotiations with you and has requested a revised offer.  

If the CO has notified you of a problem and allows you to re-submit your 
response or has entered into negotiations with you and has requested a revised 
offer, you can update the information in your offer by following the procedures 
described in “Submitting a Revised Offer on an Open Solicitation.” 

Business Rules:   
y You can withdraw your offer on a solicitation anytime 

before the solicitation closes.  
  

y If you have submitted offers to other solicitations, those 
solicitation responses will NOT be affected by the 
withdrawal request for a specific solicitation. 

To withdraw an offer, telephone or e-mail the CO that you wish to 
withdraw your offer.  The CO will ensure your solicitation response is 
withdrawn from the VIPR system. 

NOTE: The “Withdraw Offer” button on the SF 1449 form is intended 
for future functionality and is NOT currently enabled.  

VIPR Vendor Solution Quick Reference Guide 

  Submitt ing a  Revised Offer  After  a  Sol ic i tat ion Has Closed 

  Withdrawing an Offer  
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  Responding to  an Amended Sol ic i tat ion 

In the e-mail message you receive from VIPR, double-click on the amendment solicitation package file. A Save As dialog box 
appears. 

Save the amendment package in the appropriate Solicitations | <solicitation number> folder. 

NOTE: Before working with the amendment package, you may want to save a copy of the amendment package and rename 
it as “Original-<solicitation number_Amendment 1>.pff.”  

Open the amendment package and from the Form menu, select Attachments. A list of Attachments appears. 

From the Attachments list, click the Add button.  

From the Solicitations folder, select your company form, and then click the Open button. Your company form is now 
attached to the amendment package. 

From the Attachments list, select the VendorCompany.pff file, and then click the Delete button. The blank 
VendorCompany form is deleted from the package.  

From the Attachments list, click the Add button.  

From the Solicitations folder, select your resource form, and then click the Open button. Your resource form is now attached 
to the amendment package. 

Repeat Steps 7-8 for every resource data entry form you want to add to the package.  

NOTE: Be sure to attach the Representations-Certifications document and any other submittals required by the solicitation. 

From the Attachments list, select the <resource data entry form>.pff file, and then click the Delete button. The blank 
form is deleted from the package.  

Repeat Step 10 to delete all of the blank forms within the amendment package. 

Click the Close button to close the Attachments list.  

Click the Save button to save the amendment package with your company and resource data entry forms attached. 

Once your forms are attached to the amendment package, follow the instructions in “Signing and Submitting an Offer.” 

1 
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Business Rules:   
y When responding to 

an amendment, you 
can update any of 
your company 
information or 
information on 
specific resources, if 
needed, before you 
attach your forms to 
the amendment 
package. 

y When responding to 
an amendment, you 
MUST submit a 
complete package, 
which means you 
MUST ATTACH ALL of 
the resource forms 
that you want to 
include with your 
offer and that still 
apply to the amended 
solicitation.  
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If you are going to submit an offer for the first time on an amended solicitation, follow the same procedures described “Responding to a Solicitation,”  but 
download the amendment package from FBO. 

If you have already submitted an offer on a solicitation and that solicitation has been amended since you submitted your offer, VIPR will send you an e-mail 
notice informing you of the amendment and providing a link to the amended solicitation package. You will need to follow the procedures described below. 

VIPR Vendor Solution Quick Reference Guide 
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 Working with  Agreements  

Once a CO is done awarding agreements for a 
solicitation, VIPR notifies Vendors whether or not 
they have received the award.  

If you are NOT AWARDED an agreement, VIPR 
will send you an e-mail informing you that you did 
not receive an award for a specific solicitation. If 
you have questions about the award decision, 
contact the CO. 

If you ARE AWARDED an agreement, VIPR will 
send you an e-mail informing you that you have 
received an award; the e-mail will include the 
complete agreement package.  

The agreement package includes the following: 

y SF 1449 (with your eSignature and the CO’s 
eSignature) 

y SF 30 (if there were any amendments during 
the solicitation process) 

y Schedule of Items 

y Table of Contents 

y Your completed company information form 

y Your completed data entry forms for each 
resource  

y All of the contract requirements 

Once you receive an award, you can do the 
following: 

y Print the Agreement 

y Replace equipment on an agreement 

y Withdraw equipment on an agreement 

VIPR Vendor Solution Quick Reference Guide 

 Pr int ing an Agreement   

When you receive notification of award of an agreement, you MUST print the agreement, and as 
required by the agreement, when dispatched, bring to the incident a minimum of two copies of the 
complete agreement for each resource.  

To print the complete agreement, you must print the following: (1) SF 1449, (2) SF 30 (if there are 
any), (3) Schedule of Items, (4) Table of Contents, (5) Contract Requirements and Exhibits, (6) 
Vendor Company Information Form, and (7) Resource Data Entry Form. The agreement accompanying 
the resource to the incident may include only the resource data entry form associated with that 
specific resource. 

For instructions on how to print the agreement and its attachments, refer to “Printing Packages.”  

 Replac ing Equipment  on an Agreement  

If you wish to replace equipment on an agreement, 
you can do so as long as the equipment is equal or 
better.  

To replace equipment on an agreement, you will need 
to telephone or e-mail the CO on the agreement and 
request a modification to the agreement. The CO will 
issue a modification and the modification package will 
be e-mailed to you. Once you receive the modification 
package, you will use the “Replace” functionality at 
the top of the resource data entry form by following 
the procedures in “Responding to a Modified 
Agreement.”  

Business Rules:   
y If you replace equipment, it must 

be with equal or better equipment. 
VIPR will create a new DPL with 
the new equipment detail, but will 
NOT re-sort the order of the 
Vendors on the DPL. 
 

y You cannot change the price or 
the Dispatch Center for the 
replacement equipment. 

 Withdrawing Equipment  on an Agreement  

If you wish to withdraw equipment on an agreement, you will need to telephone or e-mail the CO on 
the agreement and request a modification to the agreement. The CO will issue a modification and 
the modification package will be e-mailed to you. Once you receive the modification package, you 
will use the “Withdraw this Resource” functionality at the top of the resource data entry form by 
following the procedures in “Responding to a Modified Agreement.”  
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 Responding to  a  Modif ied  Agreement  
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In the e-mail message you receive from VIPR, double-click on the modification package. 

Save the modification package to the Solicitations | <solicitation number> folder. 

Open the package and from the Form menu, select Attachments. A list of Attachments appears. 

From the Attachments list, double-click on the Modification#.pff file. The modification form (also known as the SF 30 form) appears.  

In Box 14 on the form, view the Description of the Amendment/Modification. 

Close the SF 30 form and based on the type of modification, follow the appropriate procedures listed in the “Types of Modifications” table. 

1 
2 
3 
4 
5 
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After you accept an awarded agreement, if the agreement is modified by the CO, VIPR will send you an e-mail notice informing you of the modification and 
providing a link to the modification package. You MUST respond to the modification by taking actions described on page 19 for the specific type of modification. 

When you receive notification of a modification to an agreement, you MUST print the modified agreement, and as required by the agreement, you MUST carry 
with you to the incident a minimum of two copies of the complete modified agreement for each resource. To print the complete agreement, you must print (1) 
SF 1449, (2) SF 30, (3) Schedule of Items, (4) Table of Contents, (5) Contract Requirements and Exhibits, (6) Vendor Company Information Form, and (7) 
Resource Data Entry Form. The agreement accompanying the resource to the incident may include only the resource data entry form associated with that 
specific resource. 
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For this type of modification Do this... 

CO has modified the contract 
requirements 

a. From the Attachments list, double-click on the ContractRequirements.pdf file. 

b. View the contract requirements, and then close the document. 

c. Go to Step 3 in “Signing and Submitting an Offer” to sign and submit your response to the modification. 

CO has modified their CO 
information 

No action is required, except to sign the response (go to Step 3 in “Signing and Submitting an Offer” to sign and submit your response to the modification). 

Vendor needs to modify their 
Vendor company information 

a. From the Attachments list, double-click on the VendorCompany.pff form or use your existing form. 

b. Make your updates to the form. 

c. From the File menu, select Save As and save the updated VendorCompany.pff form to your Solicitations folder, and then close the form. 

d. From the Attachments list, click the Add button and select your updated company form. 

e. From the Attachments list, select the old VendorCompany.pff form, and then click the Delete button. 

f. Go to Step 3 in “Signing and Submitting an Offer” to sign and submit your response to the modification. 

Vendor needs to withdraw a 
resource 

NOTE: There is a “withdraw” function on each resource data entry form; however, each form may vary slightly. 

a. From the Attachments list, double-click on the <resource data entry form>.pff form. 

b. In the Agreement Phase Only box (at the top of the form), select the Withdraw this resource check box. 

c. From the drop-down list, select the VIN/Serial Number that you wish to withdraw. (Some forms will not have this drop-down list because certain types of resources cannot be 
individually withdrawn [e.g., tents]. You may need to contact the CO about canceling the agreement.) 

d. From the File menu, select Save As and save the updated <resource data entry form>.pff form to your Solicitations | solicitation number folder, and then close the form. 

e. From the Attachments list, click the Add button and select your updated <resource data entry form>.pff. 

f. From the Attachments list, select the blank <resource data entry form>, and then click the Delete button. 

g. Go to Step 3 in “Signing and Submitting an Offer” to sign and submit your response to the modification. 

Vendor needs to replace a resource NOTE: Not all resource data entry forms will have the “replace” function. 

a. From the Attachments list, double-click on the <resource data entry form>.pff form. 

b. In the Agreement Phase Only box (at the top of the form), select the Replace this VIN/Serial Number check box. 

c. From the drop-down list, select the VIN/Serial Number that you wish to replace. (Some forms will not have this drop-down list because certain types of resources cannot be 
individually replaced [e.g., tents]. You may need to contact the CO about canceling the agreement.)  

d. Complete ALL of the required fields on the form with the new equipment information. 

NOTE: In order to successfully submit a response, you must select a Dispatch Center (DC) and enter data into the rate fields for the new resource data entry form since these fields 
are required; however, the data you enter into these fields will be ignored and will NOT replace the original DC and pricing information you submitted with your original offer. 

e. From the File menu, select Save As and save the updated <resource data entry form>.pff form to your Solicitations | solicitation number folder, and then close the form. 

f. From the Attachments list, click the Add button and select your updated <resource data entry form>.pff. 

g. From the Attachments list, select the blank <resource data entry form>, and then click the Delete button. 

h. Go to Step 3 in “Signing and Submitting an Offer” to sign and submit your response to the modification. 

CO has terminated the agreement No action is required. 

Vendor needs to cancel the 
agreement 

Go to Step 3 in  “Signing and Submitting an Offer” to sign and submit your cancellation. 

Types of Modifications 
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From Windows Explorer, open the Solicitations | <solicitation number> folder. 

Double-click on the <solicitation number>.pff form. The SF 1449 form opens.  

From the File menu, select Print. The Print screen opens. 

Select your print options, and then click the OK button. The form prints.  

On the SF 1449 form, from the Form menu, select Attachments. The list of the attachments associated with the solicitation opens.  

Double-click on the .pff form you wish to print. The form opens.  

In the form, from the File menu, select Print. The Print screen opens. 

Select your print options, and then click the OK button. The form prints. 

Close the form. The list of Attachments re-appears. 

Repeat Steps 6 - 9 for all of the attachments. 

Once all of the documents are printed, click the Close button on the Attachments box and close the SF 1449 form. 
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At any point in the process, you can print the forms and other documents within a solicitation, amendment, agreement, or modification package. Since 
the forms are separate documents, you will need to print one document at a time. Also, the procedures listed below for printing the forms within a 
package are the same regardless of the type of package you are printing; the only difference will be the file you open in Step 2. 

When you receive notification of award of an agreement, you MUST print the agreement, and as required by the agreement, you MUST carry with you 
to the incident a minimum of two copies of the complete agreement for each resource. To print the complete agreement, you must print (1) SF 1449, 
(2) SF 30 (if there are any), (3) Schedule of Items, (4) Table of Contents, (5) Contract Requirements and Exhibits, (6) Vendor Company Information 
Form, and (7) Resource Data Entry Form. The agreement accompanying the resource to the incident may include only the resource data entry form 
associated with that specific resource. 

  Access ing the Dispatch Pr ior i ty  L ists  (DPLs)  

You can access the Dispatch Priority List (DPL) from the Incident Procurement Web site at http://www.fs.fed.us/business/incident/vipr.php.  

http://www.fs.fed.us/business/incident/vipr.php�


 Comprehensive  L ist  of  A l l  o f  the  Business  Rules  
Below is a comprehensive list of all of the business rules highlighted throughout the user guide. 

Completing the Vendor Company Information 

y You MUST attach a completed Vendor Company Information form to EVERY offer you submit. 

Completing the Resource (Equipment/Crew) Information  

y You MUST always attach at least one completed resource data entry form for each piece of equipment to EVERY offer you submit. 

y You MUST attach one completed resource data entry form for every resource that will be in your solicitation response. For example, if your response will include two Engine 
Type 3s, then you will need to attach two Engine Type 3 forms; you CANNOT attach one form for both Engines. Another example is the Tent resource, where you must 
have one form for each Tent type. 

Signing and Submitting an Offer 

y You can continue to update your company and resource information and re-submit an offer (solicitation package) until the solicitation close date. After the close date, VIPR 
will not accept a response unless the CO has notified you of a problem and allows you to re-submit your response or has entered into negotiations and requested a revised 
offer. 

y VIPR will use the Vendor’s last response as the response on record; VIPR will NOT try to determine the difference between multiple packages for the same solicitation sent 
by the same Vendor. 

Submitting a Revised Offer on an Open Solicitation 

y You can update your company and resource information and re-submit a revised offer at any time until the solicitation close date. 

y VIPR will use the Vendor’s last response as the response on record; VIPR will NOT try to determine the difference between multiple packages for the same solicitation sent 
by the same Vendor. 

y If the information you have updated applies to other solicitations you have responded to, then you must repeat this process for those solicitation responses as well. 

Submitting a Revised Offer After the Solicitation Has Closed 

After a solicitation is closed, you CANNOT update your information for that solicitation UNLESS the CO has notified you of a problem and allows you to re-submit your response 
or has entered into negotiations and requested a revised offer.  

Withdrawing an Offer 

y You can withdraw your offer on a solicitation UNTIL either the CO has indicated that the CO is done awarding for that solicitation or you are selected as a Vendor to receive 
an agreement for the solicitation.  

y If you have submitted offers to other solicitations, those solicitation responses will NOT be affected by the withdrawal request for a specific solicitation. 

Responding to an Amendment 

y When responding to an amendment, you can update any of your company information or information on specific resources, if needed, before you attach your forms to the 
amendment package. 

y When responding to an amended solicitation, you MUST submit a complete package, which means you MUST ATTACH ALL of the resource forms that you want to include 
with your offer and that still apply to the amended solicitation.  

Replacing Equipment on an Agreement 

y If you replace equipment, it must be with equal or better equipment. VIPR will create a new DPL with the new equipment detail, but will NOT re-sort the order of the 
Vendors on the DPL. 

y You cannot change the price or the Dispatch Center for the replacement equipment. 
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You should have... To find out if you have what you need... 

Administrator rights to the PC you will use for the VIPR 
Vendor Solution.  
NOTE: You will need administrator rights to your PC to 
install Formatta Filler software. 

If you can install software onto the PC, then you have administrator rights to the PC.  

Windows® NT, 2000, XP, or VISTA 
NOTE: The Macintosh version of Formatta Filler will NOT 
work with the forms used in the VIPR Vendor Solution. In 
order to preview a VIPR package, you will need a PC that 
you can run Filler on.  

1. From the your desktop, right-click on My Computer and select Properties. 
2.  Under the System heading, note the type of system you have. 

Free Formatta Filler® software  
NOTE: You will need this software to be able to work with 
the forms used in the VIPR Vendor Solution. 

Formatta Filler installation instructions are located at the Incident Procurement VIPR Web site: http://
www.fs.fed.us/business/incident/vipr.php  

Internet Explorer® 6.0 or better, with Java script enabled 1. Open Internet Explorer. 
2. From the Help menu, select About Internet Explorer. 
3. Ensure you have Internet Explorer 6.0 or better. 
4. From the Tools menu, select Internet Options. 
5. Click the Advanced tab. 
6. Scroll down to the Java (Sun) heading and ensure the “Use JRE…” check box is selected. 

Turn off Pop-up Blocker  In Internet Explorer, you will need to either disable the pop-up blocker.    

To disable the pop-up blocker: 

1. Open Internet Explorer. 
2. From the Tools menu, select Pop-up Blocker > Turn Off Pop-up Blocker. This will turn off the pop-up 

blocker for all sites. 
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The documents that make up a complete awarded agreement including the SF-1449, the contract requirements, the schedule of items, the vendor company 
form, and all applicable resource data entry forms.  

Changes to a published solicitation.  

Offer accepted by CO.  

Contracting Officer. 

The paragraphs included in the contract. Contract requirements include clauses, provisions, and the specifications included in Sections B, C, D, and E. 

Dispatch Priority List. The DPL is the list of Vendors that dispatchers will use to fill orders for equipment on an incident.  

FedBizOpps. 

Forms tool used for the VIPR Vendor Solution. 

Incident Blanket Purchase Agreement. The document resulting from the award of a pre-season agreement, using the SF-1449. 

Helpdesk supporting VIPR. 

 

A change to an awarded agreement; multiple modifications can be associated with an award. 

Formatta forms file type. 

A class of equipment. Example: Dozer, Engine, GIS Unit. 

The documents that are processed during the solicitation stage including the SF-1449 top sheet, the contract requirements, and the Vendor’s response 
including the company information and resource forms.   

The notice published to FedBizOpps, notifying vendors that a solicitation will be issued with a summary of the requirements. 

Third-party company offering equipment and services to the Forest Service. Also known as Contractor. 

Virtual Incident Procurement; a Web-based incident procurement system that will replace and expand the Equipment and Training Inventory (EaTIS) 
prototype. COs will use VIPR to create and manage solicitations and agreements through the entire procurement process. 

A forms-based tool that Vendors use to respond to solicitations, acknowledge amendments, receive awarded agreements, and respond to any agreement 
modifications. 

Agreement Package 

 
Amendment 

Award 

CO 

Contract Requirements 

DPL 

FBO 

Formatta 

I-BPA 

Interagency Incident 
Systems Helpdesk 

 
Modification 

PFF 

Resource Category 

Solicitation Package 

 
Synopsis 

Vendor 

VIPR 

 
VIPR Vendor Solution 
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